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A B S T R A C T

Radio-telemetry studies allow the accurate measurement of the survivorship of

many vertebrates, without many of the mathematical problems associated with

capture-recapture analysis using markers such as bands, tags or toe-clips. The

assumptions involved in the analysis of radio-telemetry data are described and

rules are given for the consistent handling and analysis of data. Some examples

of different survivorship estimates are given from ongoing studies of the threats

to brown kiwi (Apteryx mantelli) in Northland, New Zealand, and from a

published study of the survival of kereru (Hemiphaga novaeseelandiae). From

the kiwi study, we give a sample Excel spreadsheet for the storage of raw data

and for processing and transferring them to the SPSS statistical package to carry

out survival analysis. We provide worked examples in Excel for the calculation

of survivorship rate using simple methods. We also give a worked example in

both Excel and SPSS for the Kaplan-Meier procedure and for testing differences

in survival between two or more groups of individuals using a log-rank (Mantel-

Haenszel) test. Under certain circumstances, these methods can be used to

estimate survivorship, and compare survival in two or more groups of animals

(or plants) marked in other ways.

Keywords: Excel, Kaplan-Meier, log-rank (Mantel-Haenszel) test, Mayfield

method, product-moment, survival analysis
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1. Introduction

Conservation managers often aim to maintain or enhance populations of

threatened species and / or reduce populations of pest species. In any animal

population, fluctuations in the number of individuals result from changes in

four different components of life history: birth rate, death rate, immigration and

emigration. It is useful for conservation managers to be able to measure or

estimate these four variables for threatened species and pest species alike. For

example, in New Zealand managers aim to increase birth rate and / or decrease

death rate of kiwi by increasing the death rate (through trapping or poisoning)

of pest species such as possums, stoats and ferrets.

This paper was written in response to requests for advice from conservation

managers in the Northland and West Coast Conservancies of the Department of

Conservation (DOC) who are collecting survivorship data on kiwi through

radio-tracking studies. We assume a basic knowledge of mathematics, and do

not go into the mathematical theory behind the tests used, but we provide some

key references that give that background for those who are interested. We also

assume an ability to use Excel spreadsheets, but a copy of an Excel workbook at

hand with real or dummy data will enhance the understanding of this paper.

The aim has been to provide a practical guide to help field workers and

researchers to record and analyse data used to calculate the death rate and

hence longevity of animals from radio-telemetry data. Some of the mathematics

used here can be more generally applied to data from studies of animals (or

plants) marked in different ways, where individuals are checked very regularly.

2. Background

2 . 1 S U R V I V A L  R A T E S

The term ‘survival rate’ is usually used as a more positive expression than death

rate or mortality rate. Survival rate, s, is the complement of the death or

mortality rate, m, i.e. s = 1 – m. For example, if 70% of kiwi survive from one

year to the next (s = 0.7), then 30% have died (m = 0.3). The probability that an

animal survives may vary with individual characteristics such as age, sex, size

and colour, or as a function of external variables such as management regime,

habitat type, exposure to predation, population density, weather or season. It is

often useful for conservation managers to compare survival rates between two

or more different groups of individuals. For example, comparisons can be made

between survival in treatment and non-treatment areas, or between males and

females (a population may be in grave danger even though the overall survival

rate appears reasonable, if there is a very low number of individuals of one

gender).
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2 . 2 M E T H O D S  A V A I L A B L E  F O R  C A L C U L A T I N G

S U R V I V A L

There is a large body of scientific literature describing methods for estimating

the survivorship of animals (and plants), much of it derived from medical and

engineering studies. The simplest method (survivorship = number of survivors/

number at start) is used when the entire initial population is marked (or

otherwise known); immigration and emigration are impossible (e.g. some birds

on islands, plants in a quadrat); all surviving animals or plants can be relocated

with confidence at fixed intervals thereafter; and all individuals have an equal

chance of surviving from one time interval to the next. Because real life is not

usually that simple, and all four conditions are seldom met simultaneously, a

number of complex mathematical methods have been developed for the

analysis of capture-recapture / resighting data when only part of the population

is marked, immigration and emigration are possible, when sampling intervals

are irregular and when chances of resighting or survival vary between

individuals (for reviews and an introduction to the literature, see Clobert &

Lebreton 1991; Lebreton et al. 1992). All methods include one or more

assumptions, such as that the animals are equally likely to be captured and then

recaptured / resighted; marked animals are not affected by being marked; or,

for some methods, the population is closed (no immigration or emigration).

The relatively recent development of radio-telemetry to mark animals removes

the need for some of these assumptions or allows assumptions to be better

examined. As a method for the field, we believe that radio-telemetry provides

the best available tool to achieve the ideal situation of being able to follow

individual wild animals from birth through to death, enabling researchers to

record the outcome of each of the animal’s breeding attempts, and to record

movements and social behaviour during its lifespan. The intensive study of a

relatively small sample of individuals can provide answers to a number of

conservation management questions more readily than alternative approaches,

such as a broader mark-recapture study.

2 . 3 R A D I O - T E L E M E T R Y

Radio-telemetry is an unrivalled technique for determining the movements,

home-range and habitat use of animals in the wild. It is also proving to be an

exceptionally useful technique for studying the survival of wild animals. A

miniature radio-transmitter is attached to a study animal by a harness, glue or

sutures. By using an aerial and receiver tuned to the correct frequencies,

researchers can track the animal manually, by automated tracking stations or by

satellite, and its location and / or behaviour can be noted. Mortality transmitters

emit a different signal (e.g. increased pulse rate) if the transmitter becomes

stationary for more than a specified length of time, thus indicating that the

animal has died or the transmitter has fallen off; these can be programmed to

change the signal characteristics in an ordered way after changing to mortality

mode, so that the time of day and date of death or transmitter loss can be

recorded.
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There are four main drawbacks to using radio-transmitters in studies of wild

animals. Firstly, the animal has to be recaptured periodically to replace the

transmitter because battery life is limited and transmitters have to be

sufficiently small (usually nominally taken as < 5% of body weight) not to

unduly interfere with the mobility of the animal. Secondly, despite

improvements in transmitter components and batteries in the last decade, some

transmitters fail well before their due date. Thirdly, only a relatively small

number of individuals (< 100) can usually be tracked in an area at one time by

an observer, often because there are only a limited number of frequencies

available. In the past, confusion has arisen when more than one research team

has been using transmitters on different study animals that overlap in

distribution. Finally, the costs of radio-telemetry can be high: standard

transmitters retail at $220–$400 each, satellite transmitters at about $5000

each, and receivers, aerials and replacement batteries are significant additional

costs.

2 . 4 A S S U M P T I O N S  I N  S U R V I V O R S H I P  A N A L Y S I S
O F  R A D I O - T E L E M E T R Y  D A T A

The most important assumption in radio-tracking studies is that the transmitters

do not interfere with the behaviour or survival of marked animals or, for

purposes of comparing two or more subsets of the study animals, if they do

cause some effect, then it is evenly or randomly spread through the entire radio-

tagged population. Another important assumption is that when a record is

entered as censored (i.e. the tracking record is completed but recorded only as

surviving to this time) the censorship should not be linked to a higher chance of

death. This assumption is clearly violated when loss of transmitter contact

occurs in conjunction with death, for example, when an animal drowns in a

river and is washed away, or during human predation, as reported for radio-

tagged kereru (Hemiphaga novaeseelandiae) at Wenderholm (Clout et al.

1995). Equally important is the assumption that a random sample has been

obtained, so that the radio-tagged sample is representative of the whole

population (e.g. kiwi chick samples should be stratified according to time of

year and geographical location because of the marked seasonal changes in the

abundance of stoats, their main predator, and because of edge effects). Another

assumption is that each animal’s fate is independent of the fate of others

(although this may not be the case if animals are killed during catastrophic

events, e.g. bad weather, fire or predator irruption, or if animals are associated

with each other, e.g. by coming from the same nest or pair). In some cases, we

make the additional assumption that the probability of survival remains

constant through time, at least within each subpopulation being studied.
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3. Rules for the handling of
survivorship data

As soon as a radio-tagged animal is released, data can start to accumulate.

However, for species that suffer post-handling shock, deaths shortly after

release are often excluded (e.g. Clout et al. (1995) excluded kereru that died

within 1 week of capture). In this case, data collection from survivors should

also start only after this window has passed.

Survivorship data must be handled carefully and consistently to ensure that

estimates made for the population are valid. For example, estimates can be

systematically in error if censoring (the cessation of a tracking record with no

evidence that the individual has died) is not correctly and accurately recorded.

When a field search is made for the animal there are five possible outcomes:

confirmation that the animal is alive; the animal is dead and the transmitter is

recovered; the animal is not found because either it has emigrated or the

transmitter has failed; a shed transmitter is found working but there is no sign of

the animal; or the animal is not actually seen (e.g. because it is in a deep

burrow) but the site of the transmitter is identified. These are outlined below.

Confirmed alive

The date on which an animal is recorded alive, with a functioning transmitter,

becomes the ‘last date’ that the animal was known to be alive. If the transmitter

is removed from the animal at this point, the data from that animal are referred

to as being ‘right censored’, i.e. the tracking record is complete even though

the animal survived beyond this date. No further information can be added to

the survivorship record after transmitter removal even if the animal is resighted

alive some time later, because only live animals are available to be resighted.

Confirmed dead

One major advantage of radio-telemetry over other methods of marking is that it

often enables researchers to find an animal’s carcass, and so determine the

cause of death either from examination of the body (necropsy) or from signs at

the site where the animal has died (e.g. a branch had fallen on the animal). For

survivorship analysis, we recommend that, wherever possible, the date of death

is estimated from the time a mortality transmitter changed its signal, the state of

decay of the carcass, or the amount of growth between last capture and the

time of death (e.g. the bills of kiwi chicks grow at a nearly linear rate in the first

6 months (R. Colbourne and H. Robertson, unpubl. data), so the time of death

can be estimated from bill length).

Where the date of death is not known, use the midpoint between when the

animal was last known to be alive and the date on which the animal was found

dead if visits are 15 or fewer days apart; where the interval exceeds 15 days, use

the date after 40% of the interval between visits has elapsed (Miller & Johnson

1978). It is important to state clearly the method used for these calculations in

reports or scientific papers.
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The animal is not found because it has either emigrated or
the transmitter has failed

Similar rules apply to those used when the animal has died (see above): censor

records at an intermediate date between when the animal was last known to be

alive and the first time the animal was searched for and not found, using the

methods proposed by Miller & Johnson (1978). It is important to record dates

on which an animal was searched for and not found, because that information

will be used in subsequent calculations of censoring date if the animal is not

later found with a functioning transmitter. If the animal reappears bearing a

non-functioning transmitter, then the above dates must be used rather than the

time it reappeared to avoid increasing the apparent survival rate, since only live

animals can reappear. If the animal reappears bearing a functioning transmitter,

then the record reverts to being a continuous record from first capture to the

date of reappearance. But, in the unlikely event that the animal is later found

dead with a non-functioning transmitter, assume that it was alive at the time it

disappeared from the tracking record unless it is obvious that death and

transmitter failure were simultaneous (e.g. when an animal has been killed by a

poacher who has destroyed the transmitter).

The shed transmitter is found working but there is no sign
of the animal

Similar rules apply to those used when the animal has disappeared, with the

tracking record being censored at an intermediate time between when the

animal was certainly alive and when the transmitter was found. If the animal is

later found alive, the original endpoint must stand because of the danger of

introducing a bias toward increased survivorship.

The animal is not actually seen (e.g. is in a deep burrow)
but the site of the transmitter is clearly identified

If the study animal is of a species or age class that is regularly cryptic (e.g. adult

kiwi, which often use very deep burrows), then assume that the animal is alive.

However, if subsequent searches always lead to the same site, censor the record

at an intermediate point before the first record for that site. Whether the animal

has died or shed its transmitter in an inaccessible site can be difficult to

determine and other cues, such as a resighting (or no resighting), a rotting smell

or blowflies associated with the site, or its partner being found with a new

mate, must be used.

If the study animal is found in a highly unusual site (e.g. a kiwi chick in a non-

natal burrow), then assume that the individual died at an intermediate stage

before the first encounter at this site (although note that a dead kiwi chick was

once dragged from one stoat den to another between checks; Pat Miller, pers.

comm.).
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4. Management of data

One of the authors (H.A.R.) developed an Excel spreadsheet for handling

survivorship data from a large-scale (c. 100 birds marked at any point in time)

radio-telemetry study of the threats to wild brown kiwi (Apteryx mantelli) in

central Northland, New Zealand (see Robertson et al. (1999) for more

information on the study). The spreadsheet used for storing survivorship

information about adult brown kiwi from 2 January 1994 to 30 September 1998

is given in Appendix 1 (N.B. data on other age classes of brown kiwi were kept

separate because different assumptions apply to them). The following columns

are used:

‘Band’ and ‘Combination’ identify particular individuals. It is not necessary to

include both variables, but they do provide useful checks if there is an

identification error in the field or a transcription error from field notebooks

to the computer.

‘Sex’ identifies the sex of the bird.

‘Area’ identifies the study area in which the bird was located.

‘Tx’ refers to the most recent transmitter frequency used for the animal. This is

also a useful check on the identity of the bird, as band numbers are often

obscured by reflective tape.

‘On’ stores the date on which the continuous record of radio-tracking of each

bird started. Dates are best shown with one or two digits for days, three

characters for the month, and a two-digit year to avoid ambiguities, e.g. 4-

Mar-97 rather than the ambiguous 4/3/97 which could be 4 March or 3 April

1997, depending on the calendar system used. This can be set up in Excel by

highlighting the column, using Format > Cells > Custom, and then

choosing d-mmm-yy from the options.

‘Off_last’ is the date the transmitter was removed from a kiwi; the estimated or

calculated time of death; the date the record was censored (when a

transmitter fell off, failed or the bird disappeared); or the most recent date

the functional transmitter was known to be on the bird.

‘Total’ is the total tracking period. This is found by subtracting the ‘On’ date

from the ‘Off_last’ date. Excel will want to format this as a date (e.g. 23-Nov-

1900). To format cells in this column as numbers, use Format > Cells >

Number, and choose Number from the category list. To be tidy, set the

number of decimal places to 0. For example, in the first row, the female kiwi

with band number 1079 with blue reflector and Tx 37 was caught and radio-

tagged at Purua on 29 June 1994 and the transmitter was removed on 10

March 1995 after 254 days.

‘Death’ is an indicator of whether the record ended with a death (recorded as 1)

or not (recorded as 0), the latter corresponding to a censored observation.

This should remain at 0 even if an animal is subsequently found dead without

a functioning transmitter, as only deaths during the tracking period can be

used in estimates of survivorship.
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One useful convention is that all ongoing records are shown in bold, all records

ending with the animal definitely dying are in italics, and all records that ended

with the transmitter being removed, falling off or failing (the last is assumed

after only a reasonable time, in case the animal reappears with a functional

transmitter) are in normal font. Using different typescripts does not affect the

numerical calculations and it makes it easier to locate particular individuals or

groups in the spreadsheet, especially when updating the files. Alternatively, a

separate column can be added to note the status of each tracking record (alive,

dead, missing…).

5. Calculation of annual
survivorship and life expectancy

5 . 1 T I M E  S C A L E S

For long-lived animals, such as brown kiwi, it is usual to calculate and report

annual survival estimates. However, for short-lived animals, such as kiwi chicks,

or for short-term radio-tracking studies, it is better to calculate daily, weekly or

monthly survival rates. These can be calculated by raising the survival rate (not

the mortality rate!) to the appropriate power, e.g. a monthly survival of 0.90

equates to an annual survival of 0.90¹² = 0.28, assuming constant survival

throughout the year. Be aware of the effect of raising a rounded number by a

large power, as the final result may be quite different from the true result. In the

example above, if the true monthly survival rate had been 0.9048, then the

annual survival would have been 0.3010. The effect is greatly magnified when

converting daily survival rates to annual rates.

5 . 2 T H E  M A Y F I E L D  M E T H O D

The Mayfield method for analysing nesting success of birds (Mayfield 1961,

1975) is often extended to the analysis of radio-telemetry data (e.g. Trent &

Rongstad 1974; Heisey & Fuller 1985). It provides a simple approximation of

mortality by dividing the number of deaths, d, by the total time, T, that animals

have carried active radio-transmitters. This approach is based on two

assumptions: that the mortality rate is constant and the sample is random. For

example, Clout et al. (1995) recorded ten deaths (d) of radio-tagged kereru at

Pelorus Bridge in 19 321 bird-days (T = 52.9 years), which gave a crude

mortality rate, m, of 10/52.9 = 0.189 per bird per year; an annual survival, s

(= 1 – m), of 0.811 or 81.1% per year; and a life expectancy, L (= 1/m), of 5.29

years.
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From the data in Appendix 1, there were 13 adult brown kiwi deaths in 258.87

bird-years of radio-tracking in central Northland to September 1998, so

mortality is 13/258.87 = 0.0502, annual survival is 0.9498 and life expectancy is

therefore 19.91 years. It is possible to calculate confidence intervals for these

estimates. A confidence interval for mortality rate is:

where 1 – α is the confidence level (for example α = 0.05 for a 95% confidence

interval) and the appropriate values for the χ2 distribution with 2d degrees of

freedom are derived from a statistical table or computer function (Lawless

1982). A confidence interval for life expectancy is given by the reciprocals of

the limits calculated for mortality. For the adult brown kiwi example above, the

required χ2 values (with 26 degrees of freedom) are 13.8 and 41.9, calculated

from the Excel formulae =CHIINV(0.025,26) and =CHIINV(0.975,26). Thus

the 95% confidence interval of the mortality rate is 0.0502/26 × 13.8 = 0.027 to

0.0502/26 × 41.9 = 0.081, and the associated 95% confidence interval for life

expectancy becomes 12.4 to 37.4 years.

This method assumes that survivorship is constant. Where this assumption is

not violated it provides reasonable estimates of survivorship, especially where

sample sizes are large, i.e. the product of the number of tracking years and the

number of deaths recorded is > 500 (e.g. ten deaths in 50 years of accumulated

radio-tracking data), and can be computed and updated very simply at the foot

of the spreadsheet used for storing the survivorship data (see Appendix 1).

5 . 3 K A P L A N - M E I E R  P R O C E D U R E

Constant survival is a strong assumption to make. Unless there are very good

reasons to make this assumption, a more general and mathematically correct

method for the detailed analysis of survivorship data from radio-telemetry

studies is the Kaplan-Meier (KM) procedure, which produces a nonparametric

estimator also known as the ‘product limit estimator’ (for more detailed

discussion of the method see Pollock et al. 1989a,b; Bunck et al. 1995; Klein &

Moeschberger 1997). The KM approach is available in many statistical packages,

and is straightforward to run in SPSS, where it is available as an add-in:

‘Advanced Models’. For those people who do not have access to commercial

statistical packages, we show how, with some manipulations, simple KM curves

can be created in Excel. The KM method has the significant advantage that it

does not include the assumption that survival rates are constant.

Next we provide a worked example of the KM approach in action in SPSS. The

data in Appendix 2 give survivorship information about brown kiwi chicks

living in forest patches in Northland under different management regimes: in

some bush patches the anticoagulant poison brodifacoum was used for possum
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control (and probably caused incidental control of rodents and mammalian

predators), and in others no management was carried out (Robertson et al.

1999). The data reported here differ slightly from those reported by Robertson

et al. (1999) because we have censored observations at an intermediate point

according to the rules given above, rather than the more conservative approach

they used of censoring data at the last date the animal was known to be alive.

The data columns are similar to those in Appendix 1, but ‘Treatmen’ has been

added to enable comparison of the survival of chicks under different

management regimes. Data columns start at the top left hand corner of the

worksheet, and have simple unique names of up to eight characters in the

top row. It is easiest if there are no blank rows, and no extraneous data or

derived sums or rates in the worksheet.

5.3.1 Kaplan-Meier procedure using SPSS

The first step is to create a copy of the data in SPSS. This is most easily done by

importing the Excel worksheet into SPSS. Note that the essential variables for

any KM analysis are one for the survival time and another for whether the

record ended with a particular event (a death in this example). Additional

variables can be used to indicate groups being compared.

Open SPSS then Open > Data >
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Select Files of type Excel (*.xls), then find and click on the file to be opened

following normal Windows procedures.

Clicking on the Open button should lead to the next box:

Select the appropriate worksheet. SPSS takes a guess at the range (shown as

[A1:K162] in the upper box). This may need to be adjusted by typing the actual

range desired in the lower box. When the range is correct, click on OK.

SPSS may give ‘********’ in columns for dates (i.e. On and Off_last), which can

usually be fixed by widening the column to fit the date in.

(Note that although SPSS looks a bit like a spreadsheet, it is very different from

Excel. The two tabs are for two different views of the data: the Data View,

showing all the values, and the Variable View, showing the characteristics

associated with each column of data, which SPSS sees as a statistical variable.

The data may need to be tidied up in Excel or in SPSS to make it into tidy

columns of variables.)
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To create Kaplan-Meier survival curves, select Analyze > Survival > Kaplan-

Meier.

Then select the time variable (in our example Cdays) and use the arrow button

to put this in the Time box and the event indicator (in our example death) into

the Status box.

With the death box selected, SPSS must be told what the values of death mean.

In the example, 1 signifies a death and anything else is censored.


	Abstract 
	1. Introduction 
	2. Background 
	2.1 Survival rates 
	2.2 Methods available for calculating survival 
	2.3 Radio-telemetry 
	2.4 Assumptions in survivorship analysis of radio-telemetry data 

	3. Rules for the handling of survivorship data 
	4. Management of data 
	5. Calculation of annual survivorship and life expectancy 
	5.1 Time scales 
	5.2 The Mayfield method 
	5.3 Kaplan-Meier procedure 
	5.3.1 Kaplan-Meier procedure using SPSS 





